TP 8 des architectures logicielles
Séance 8 : Industrialisation de projet a travers

Installation du plugin m2e

Maven

Le plugin m2e est désormais géré par la fondation eclipse :

€ > C 8 hps/wwwadipseorg

= eclipse

m2e clipse

Maven Integration (m2e)

your in-house Maven repository,

Home Download Documentation Support Developers

The goal of the m2e project is to provide a first-class Apache Maven support in the Eclipse IDE, making it easier 1o edit
Maven's pem.xml, run a build frem the IDE and much mere, For Java developers, the very tight integration with JDT greatly
simpiifies the consumption of Java artifacts either being hosted cn open source repositories such as Maven Central, orin

m2e is aiso & platform that let others provide better integration with additional Maven pluging (¢.9. Android, wed

Download
Eclipse Distribution
. g

Wiki, Commit

Committers

u Benjamin Bentmann
= Igor Fedorenko

u Jason Van Zyl

= Milos Kleint
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Installing m2eclipse

[blnstall

All downloads are provided under the terms and conditions of the Eclipse Foundation
Software User Agreement unless otherwise specified.

m2e is tested against Eclipse 4.4 (Luna).

See http://wiki.eclipse.org/M2E_updatesite_and_gittags for detailed information about
available builds and m2e build repository layout.

m2e 1.3 and earlier version have been removed from the main m2e update site. These
old releases are still available and can be installed from repositories documented in
http://wiki.eclipse.org/M2E_updatesite_and_gittags

Please note that links below point at Eclipse p2 repositories: you must access them from
Eclipse (see how).

Update Sites

Latest m2e release (recommended)
m2e milestone builds towards version 1.6
http://download.eclipse.org/technology/m2e/milestones/1.6

Latest m2e 1.6 SNAPSHOT build (not tested, not hosted at
eclipse.org)

https://otto.takari.io/content/sites/m2e.extras/m2e/1.6.0/N/LATEST/
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Help

0

| €& Welcome
1®

1 G®

Help Contents
Search
Dynamic Help

Key Assist...

Tips and Tricks...

Report Bug or Enhancement...
Cheat Sheets...

Check for Updates

Install New Software...

@ 3 @& & &

Installation Details
Eclipse Marketplace...

About Eclipse
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{r Install - oIl
Available Software ) ! !
Select a site or enter the location of a site.
Work with:  type or select a site Add... ‘
Find more software by working with the "Available Software Sites" preferences.

type filter text

|

Name
[]® There is nossite 5

Select All Des|

Details

Show only the latest versions of available software

Group items by category

Version

[_] Show only software applicable to target environment

Contact all update sites during install to find required software

integration-eclipse-maven-m2e-4

Hide items that are already installed
What is already installed?

<>



Available Software ' ! l
Check the items that you wish to install.

Work with: = Maven Plugin : m2e - http://download.eclipse.org/technology/m2e/releases v Add...

Find more software by working with the “Available Software Sites” preferences.

' type filter text

Name Version
- ﬂiﬂ Maven Integration for Eclipse
%‘A m2e - Maven Integration for Eclipse (includes Incubating components) 1.5.0.20140606-0033
%3 m2e - slf4j over logback logging (Optional) 1.5.0.20140606-0033
< >
Select All Deselect All 2 items selected
Details

V] Show only the latest versions of available software Hide items that are already installed
V] Group items by category What is already installed?

("] Show only software applicable to target environment

V] Contact all update sites during install to find required software

@ < Back Next > Finish Cancel
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“ Installing Software

1 Always run in background

Runin Background|  Cancel | Details >>
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Une fois terminé, redémarrez Eclipse. caa y est, le plugin est installé. Reste a le configurer...

Configuration du plugin m2e




2 configurations a gérer :

— L'installation de Maven
— Le fichier settings.xml

Analysez les préférences maven :

L} Preferences [= @@
AL - Maven Qoo -
8 Do
Archetypes =
Discovery Do not automatically update dependendes from remote repositoties
Installstions [ Debug Cutput
Lifecydle Mappings 0 T
Templates C
User Inkerface [ Download Artact JavaDoc
User Settings Download repository index updates on startup
dap M;:’avnmas [[Jupdate Maven progcts on startup
& Phug-in Development [[]Hide folders of physicaly nested modules (expetimental)
[+ Remote Systems
# RunjDebug §
& Server
& Team 3 [Restove Defauls ] [ Apply ]
o Taeroinal —
-
\?) [ QK I [ Cancel ]

tutoriel-eclipse-maven-m2eclipse-marketplace-3

» Identifiez l'installation de Maven utilisée par Eclipse (ici Maven embarqué).

(} Preferences

\ .

#) Java Persistence
3 JavaScript
= Maven
Archetypes
Discovery
Lfecycle Mappings
Templates
User Interface
User Settings
Warnings
4 Mylyn
#) Plug-n Development
1 Remote Systems
#-Run/Debug
4 Server
4 Team
Termnal
Valdation
3 Web

@

3 |

|%

Installations =1 v

Select the Instalation used to launch Maven: A

Embedded (3.0.4/1.3.1.20130219-0923)

Note: Embedded runtime is akvays used for dependency resokution, but
does not use global satbings when it is usad to launch Maven. To learn
more, visk the [Maven web page.

Global settings for embedded installation:

||§rcwse... 3

[ ok [ caxa |

tutoriel-eclipse-maven-m2eclipse-marketplace-4

» Imposez a Eclipse d’utiliser votre installation de Maven.

Menus




Ce plugin rajoute plusieurs menus :

» Pour créer de nouveau projet avec des wizards en faisant [ File > New > Other... > Maven ] :

)
B} New [ ][O [t

Select a wizard —<>
Create a Maven Project {
Wizards:
[ type filter text
4 (= Maven

1, Checkout Maven Projects from SCM
% Maven Module
M Maven Project |

@ < Back Next > Finish

» Pour importer des projet Maven déja existant en faisant [ File > Import... > Maven ] :

)
@) Import EE

Select
pY
Import Existing Maven Projects H

Select an import source:

type filter text

b (= Java EE
4 (= Maven
1, Check out Maven Projects from SCM
', Existing Maven Projects |
(), Install or deploy an artifact to a Maven repository
1, Materialize Maven Projects from SCM

@ < Back | Next > ’ Finish

P Pour configurer Maven en faisant [ Window > Preference > Maven ] :



[ )
i@] Preferences :

| type filter text User Settings e
4 Maven o -
grchetypes User Settings (open file): T
Inlsstc:'::gns C:\Users\Yannick\.m2\settings.xml ‘ﬂ

Templates _ Update Settings
User Interface 3

| User Settings |

WTP integration Local Repository (From merged user and global settings):
» Mylyn = - .
b Plug-in Development [= C:\Users\Yannick\.m2\repository | Reindex I AL

® [ oK ] [ Cancel ]

» Pour lancer, dans le menu Run As une phase de maven :

> =% monappli Run As 4

m2 1 Maven build Alt+Shift+X, M
m. ] -
P monappli- Debug As » | m2 2 Maven build...
b =4 monappli- .
™. . Profile As » | m2 3 Maven clean
b = monappli
> &2 monappli- Team » | m2 4 Maven generate-sources
b &2 proficio Compare With » | m2 5 Maven install
> & webapp Restore from Local History... m2 6 Maven test
»
e Run Configurations...
L N

» Pour éditer un fichier pom.xml avec I'onglet du méme nom :

[ Project Explorer 52 = B (M| monappli/pom.axml §3 = O

B <§)| e <?xml version="1.8" encoding="UTF-8"?> -~
=kproject xmlns="http://maven.apache.org/Por/4. A

) -
4 ' monappli <modelVersion>4.0.0</modelVersion>

> (= monappli-dao

> (= monappli-domaine
> (= monappli-service

> (&= monappli-web

m. | »

<groupId>com.objis.demomaven</groupId>

<version>1.@-SNAPSHOT</version>

= Tm— <packaging>pom</packaging> AL
> =2 monappli-dac - M| ’
«[om > Overview ‘ Dependency Hierarchy | Effective POM vpom.xml_[ ”

» Note : I'onglet Dependency Hierarchy remplace I'ancien onglet Dependency Graph. Il permet de voir
I'arborescence des dépendances :



[m] monappli/pom.xml [m] monappli-web/pom.xml §2 = 8

Dependency Hierarchy [test] Filter: s 11 7| =
Dependency Hierarchy =l | 12 w0 [ Resolved Dependencies Ugg 2L ﬂ

O junit:3.8.1 [test] O junit: 3.8.1 [test]
= monappli-domaine : 1.0-SNAPSHOT [compile] =% monappli-domaine : 1.0-SNAPSHOT [compile]

= monappli-service : 1.0-SNAPSHOT [compile] = monappli-service : 1.0-SNAPSHOT [compile]

Overview | Dependencies l Dependency Hierarchy[ Effective POM{ pom.xmw

Import d’un projet maven

Nous allons importer dans eclipse le projet maven monappli que nous avons fabriqué au TP 5 et 6. Nous
voulons aussi visualiser les dépendances et en rajouter.

P Lancez le wizard pour I'import en faisant [ File > Import... > Maven > Existing Maven Projects > Next

1:

f ~
i@] Import Maven Projects L@g

Maven Projects

Select Maven projects

Root Directory: C:\objis\forma_Maven\TPs\TP5\monappli v

Projects:

4 [V]|/pomxml com.objis.demomaven:monappli:l.O-SNAPSHOT:pom\‘ Select All
monappli-domaine/pom.xml com.objis.demomaven:monapg

monappli-service/pomaxml com.objis.demomaven:monappli-| | Deselect All
V| monappli-dac/pom.xml com.objis.demomaven:monappli-da
PP p ] PP Refresh

monappli-web/pom.xml com.objis.demomaven:monappli-we

< | T | »

("] Add project(s) to working set

Working set: v More...

» Advanced

@ <Back || Net> || Finish || Concel |

b Sélectionnez I'emplacement du projet monappli a I'aide du bouton [Browse...], cochez le premier pom
et cliquez sur [Finish].

P Observez la structure de votre projet en regardant avec I'onglet Dependency Hierarchy le pom du
module monappli-web :




[w] monappli-web/pom.xml 2 = 8

Dependency Hierarchy [test] Filter: x 17|
Dependency Hierarchy B | laz oo (3 Resolved Dependencies g[]u 3::9 u
(j junit: 3.8.1 [test] (j junit: 3.8.1 [test]

=% monappli-domaine : 1.0-SNAPSHOT [compile] |
4 =% monappli-service : 1.0-SNAPSHOT [compile]
= monappli-domaine : 1.0-SNAPSHOT [compile]
=% monappli-dac : 1.0-SNAPSHOT [compile]
4 =% monappli-daoc : 1.0-SNAPSHOT [compile]
=% monappli-domaine : 1.0-SNAPSHOT [compile]

= monappli-dao : 1.0-SNAPSHOT [compile]
= monappli-domaine : 1.0-SNAPSHOT [compile]
I=* monappli-service : 1.0-SNAPSHOT [compile]

Overview | Dependencies ‘ Dependency Hierarchy[ Effective POM| pom.xml|

» Observez maintenant les dépendances du module monappli-dao avec l'onglet Dependency Hierarchy :

[m] monappli-web/pom.xml [m] monappli-dao/pom.xml §2 = B
Dependency Hierarchy [test] Filter: % -] & m
Dependency Hierarchy B ® | 12, oo a Resolved Dependencies ggg - 3

3 junit:3.8.1 [test]

@ junit: 3.8.1 [test]
=% monappli-domaine : 1.0-SNAPSHOT [compile]

= monappli-domaine : 1.0-SNAPSHOT [compile]

Overview { Dependencies | Dependency Hierarchy’ Effective POM ] pom.xml ’

Ajout d’'une dépendance

» Nous voulons maintenant rajouter dans le module monappli-dao la dépendance hibernate. Pour trouver
le text a rajouter au pom nous allons le chercher en allant sur le site http://search.maven.org, en
écrivant hibernate dans le premier champ et en cliquant sur search :

= The Central Repositc x

€& > C [ searchmaven.org

iy =

The Central Repository

The Search Engine for The Central Repository

e o

New: About Central Advanced Search | APl Guide | Help

SEARCH | ADVANCED SEARCH | BROWSE | QUICK STATS

Apache Maven Resources | About Sonatype | Privacy Policy | Terms of Service

Apache snd Apache Maven sre rademarks of the Apache Software Foundation. The Central Repository is 8 service mark of Sonatype, Inc. The Central Repository is intended 1o

complement Apache Maven and shoukd not be confused with Apache Maven. Copyright 82011 Sonatype. Inc.

eclipse-m2e-ajout-dependance

» Cliguez sur le lien pour afficher le module hibernate-core :



The Central Repositc x

€ - C [ searchmaven.org/#search%7Cga%7C1%7Chibernate%20core fa 9%

‘nibemate core SEARCH

New: About Central Advanced Search | API Guide | Help

= [he Central Repository o | ovinceseascn | srowse | ucksrirs (

Search Results <1 > displaying 1to 19 of 19
Groupld Artifactid Latest Version Updated Download
26-Sep-
org.hibernate hibernate-core-parant 2 all(2) 2008
436 Final all 17-Jul-
org.hibernate - pom jar sources jar
(102) 2014
. 25-Sep-
org kuali student core ks-hibernate 203-cm all (4) 2014
12-Sep- v

eclipse-m2e-ajout-dependance-hibernate-2

» Choisissez la derniére version. Vous pourrez ainsi voir le text a copier et coller dans votre pom :

[/ = The Cenal Repostc « I ——

€ - C [3 searchmaven.org/#search%7Cga%7C1%7Ca%3A%22hibernate-core%22 vy =

g The Central RepOSitory SEARCH | ADVANCEDSEARCH | BROWSE | AQUICK STATS
’a:"mbemate-oore'

New: About Central Advanced Search | APIGuide | Help
Search Results <1 displaying 1102 of2
Groupld Artifactid Latest Version Updated Download
org.hibernate hibernate-core .3.6.Fna|‘ 17-Jul-2014 pom far sources.ar
com google code maven-play-plugin org hibernate hibernate-core  4.1.3 Fin. -play- al ) 27-Jun-2014  pom jar javadociar sources iar

<1 =>displaying 1to 2 of 2

Apache Maven Resources | About Sonatype | Privacy Policy | Terms of Service
Apache and Apache Maven are trademarks of the Apache Scftware Foundation. The Central Repository i a service mark of Sonatype. Inc. The Central Repository i ntended %o
complement Apache Maven and should not be confused with Apache Maven. Copyright 2011 Sonatype, Inc.

eclipse-m2e-ajout-dependance-hibernate-3



[ = The Central Reposito « N

’

C DO search.maven.org/#artifactdetails%7Corg.hibernate%7Chibernate-core%7C4.3.6.Final%7 Cjar

= The Central Repository

SEARCH | ADVANCED SEARCH |
a:"hibernate-core" ‘ SEARCH
New: About Central Advanced Search | API|Guide | Help

Artifact Details For org.hibernate : hibernate-core : 4.3.6.Final

Click on a link above to browse the repository.

Groupld lotghlbemale
Artifactid ‘hnbernate-core

Version |4.3 6 Final

Dependency Information

<dependency
<groupld>org.hibernate</groupldy
<art1fact!d>hibernate core</artifact!d>|

Apache Buildr

<?xml versione"1,0" encoding="UTF-8"?><project xmlns="hitp://maven,apache, org/POl/4.2.0
<modelVersion>4.0.0¢/modelVersion>
<groupIld>org.hibernate</groupld>
<artifactId>hibernate-core</artifactld>
<version>4,3.6,Finsl</version>
<dependencies>
<dependency>
<groupld>grg.iboss. logeina</groupld>
<artifactId>jboss-logging</artifactld>
<version>3,1.3.GA</version>
<scope>compile</scope>

</dependency>

<dependency>
<groupld>org. ]boss loggmg</groupm>
<artifactId>i ns</artifactId>

<version>1.2.0. Beta1</versmn>
<scopercompilec/scope>

</dependency>

<dependency>
<groupld>gre.iboss. spec. javax . transaction</groupld>
<artifactId>jboss-transaction-api 1.2 spec</artifactId>

Apache Ivy

Groovy Grape <version>1.0.2.Finsl</version>
Gradle/Grails <scope>compile</scope>

Scala SBT <faependency>

Leiningen - |

r

BROWSE

/4

w

L]

QUICK STATS

Project Information Project Object Model (POM)

xm

eclipse-m2e-ajout-dependance-hibernate-4

» Une fois votre pom modifié et votre projet compilé observez a nouveau les dépendances du module

monappli-dao :

[m] monappli-web/pom.xml [m] monappli-dac/pomxml £2 =
Dependency Hierarchy [test] Filter: % 1|
Dependency Hierarchy = | 13, w0 Resolved Dependencies ugg S

@ junit:3.8.1 [test] f antlr: 2.7.7 [compile]

=% monappli-domaine : 1.0-SNAPSHOT [compile]
4 ('j hibernate-core : 4.1.8.Final [compile]
() antlr:2.7.7 [compile]
() jboss-logging : 3.1.0.GA [compile]
() jboss-transaction-api_1.1_spec: 1.0.0.Final [compile]
() domdj:1.6.1 [compile]
() hibernate-jpa-2.0-api: 1.0.1.Final [compile]
() javassist: 3.15.0-GA [compile]
4 () hibernate-commons-annotations : 4.0.1.Final [compile]

| ) jboss-logging : 3.1.0.CR2 (omitted for conflict with 3.1.0.GA)

) domdj:1.6.1 [compile]
) hibernate-commons-annotations : 4.0.1.Fir

oI C

1

) hibernate-core : 4.1.8.Final [compile]
) hibernate-jpa-2.0-api : 1.0.1.Final [compile]
() javassist : 3.15.0-GA [compile]
() jboss-logging : 3.1.0.GA [compile]
() jboss-transaction-api_1.1_spec : 1.0.0.Final
O junit: 3.8.1 [test]
=% monappli-domaine : 1.0-SNAPSHOT [com

1]I 10

| »

m

Overview ] Dependencies } Dependency Hierarchyl Effective POM| pom.xml|

P Bravo, vous savez maintenant comment importer un projet Maven dans Eclipse et jouer sur ces

dépendances.

Installation du plugin Subclipse




» Vous pouvez aussi importez dans Eclipse un projet Maven a partir d’un repository SVN. Par la suite
Vous aurez ausssi besoin de pousser vos projet Maven vers ce repository. Vous avez donc besoin du
plugin Subclipse que nous allons installer.

» Cliquez sur [ Help > Install New Software... ] :

» Entrez |'url suivante dans le champ work with : http://subclipse.tigris.org/update_1.8.x

i@ Install @Elg

Available Software |

Check the items that you wish to install. f)l—

Work with:  http://subclipse.tigris.org/update_1.8.x v

Find more software by working with the "Available Software Sites” preferences.

type filter text

Name Version

> [¥] 000 Subclipse
» [¥] 000 SVNKit

| SelectAll | | Deselect Al 9 items selected

Details

Show only the latest versions of available software ("] Hide items that are;ll
Group items by category What is already installe
("] Show only software applicable to target environment

Contact all update sites during install to find required software

@ [ oo

» Cliquez sur [ Add... ], cochez Subclipse et SVNKit et cliquez sur [ Next > ]



-
i@ Install

Install Details

Review the items to be installed.

&

Name

g+ CollabNet Merge Client
= INA Library
§* Subclipse (Required)

% Subversion Revision Graph

i+ SVNKit Library

% Subclipse Integration for Mylyn 3.x (Optional)
% Subversion Client Adapter (Required)
(4 Subversion JavaHL Native Library Adapter

% SVNKit Client Adapter (Not required)

Version

3012
3.4.0.t20120117_1605
1818

300

183

1781

111

1781

1.7.8.19538 _v201301...

< | m

'

Size: 15 051 KB

@ oo [
—4
» Eclipse vous donne le détail de ce qui va étre installé, cliquez sur [ Next > ]
E.} Install o K =L
Review Licenses
Licenses must be reviewed and accepted before the software can be installed. \ID
Licenses: License text:
;> Copyright (c) 2008 Timothy Wall, All Rigl| Copyright (c) 2008 Timothy Wall, All Rights Reserved -

> Eclipse Public License - v1.0
> Subclipse Software User Agreement
> Subclipse Software User Agreement

b
b
D
> The TMate Open Source License

This library is free software; you can redistribute it and/or
modify it under the terms of the GNU Lesser General Public
License as published by the Free Software Foundation; either
version 2.1 of the License, or (at your option) any later version.

This library is distributed in the hope that it will be useful,

but WITHOUT ANY WARRANTY; without even the implied warranty of
MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE. See the GNU
Lesser General Public License for more details. >

@ I'accept the terms of the license agreements

(0 Tdo not accept the terms of the license agreements

@

Finish Cancel

Next > (

J |

b Acceptez les termes du contrat de la licence et cliquez sur [ Finish ]

» Patientez pendant l'installation :




M Y
i@} Installing Software [_IM

‘/6\' Installing Software
L * 4

Fetching org.tigris.subversion.clientadapter.ja...p://subclipse.tigris.org/update_1.8 x/plugins/

("] Always run in background

[Run in Background] [ Cancel ] [ Details >>

» Si un Warning apparait cliquez sur [ OK ] afin de poursuivre l'installation :

r A
E.} Security Warning L@'Q

o Warning: You are installing software that contains unsigned content. The authenticity
/‘_k or validity of this software cannot be established. Do you want to continue with the
installation?

| oK { [ Cancel ] [ Details >>

maven_subclipse_5

» A la fin de l'installation acceptez de redémarrer Eclipse :

r N
i@] Software Updates ﬂ
‘/f_\\ You will need to restart Eclipse for the changes to take effect. Would you like to
Y restart now?

[ Yes ] [ No

» Bravo, vous pouvez maintenant pleinement de toute la puissance de svn dans Eclipse. Vous aurez
I’'occasion d‘aller plus loin sur ce sujet au TP 13.

Conclusion

Dans ce tutoriel, vous avez appris a utiliser des fonctionnalités de maven dans Eclipse, a jouez sur les

dépendance d'un projet et a préparez la récupération et le partage de vos projet maven avec le plugin
Subclipse.



